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QTM - Getting started

Introduction
The Getting started manual includes the basics of how   to use QTM with a Qualisys 
camera system. For a detailed description of all   of the features please refer to the QTM   
User manual. The complete manual can be found in PDF format on   the entry for QTM 
in the Windows Start menu. It can also be found in HTML   format in QTM on the Help 
menu.

On the Client login site at www.qualisys.com, you can   find the current version of QTM, 
manuals, plug-ins and other information.   Use your QTM user name and license key to 
log in. If you have any other   questions please send it to support@qualisys.se.

The following subjects are described in the Getting started   manual.

System setup
How to connect the Oqus system and set up the computer.

QTM user interface
Basic information about the QTM user interface, including a short description   of 
the different windows and menus.

QTM capture settings
Information about the basic settings needed to be able to capture a measurement,   
including calibration setting and camera settings.

Calibration
How to perform a calibration.

Capture
How to make a capture/batch capture.

Processing
A short description of the different processing steps and a more detailed   
description of AIM (Automatic Identification of Markers).
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System setup

Install QTM
Make sure you are logged in with an administrator account   before you start installing 
QTM. To install the software, connect the QTM   installation USB stick to the computer. 
You will find the QTM installer (QTM_2_xx_Build_xxxx_Setup_xxxxxxxx.exe) in the 
QTM software folder. Run it and follow the instructions given during the installation.

 Note: QTM will also install the DHCP   server called QDS which is needed for the 
Oqus cameras

The first time QTM is started you must enter a user name   and a license key, which you 
will find on the inside of the front cover of the "QTM Getting started" binder.

 Note: If the license is time limited   you must check the Time limited checkbox   and 
enter the correct expiration date.

If there is an internet connection, QTM will automatically   check for updates when it is 
started. You can also use the Check   for updates option on the Help   menu. If the QTM 
computer does not have an internet connection, you can   look for the latest software 
from another computer on the web page www.qualisys.com by logging in with your 
client account. For information on how to register a client account, ask you lab 
manager, or see the instructions at http://content.qualisys.com/2015/11/login-
instructions.pdf. 

 Setting up an Oqus system
Before you connect the Oqus camera system, make sure   that the QDS (Qualisys DHCP 
server) is running and that the network interface   settings are correct. For more 
information about QDS see section “QDS” on page 14.

The Oqus system is easy to setup. The connectors are   unique and cannot be connected 
to the wrong ports. Further, the connector   color matches that of the port. The DATA   
connector can be connected to any of the two DATA ports, and the POWER connector 
can be connected to   any of the two POWER ports, so   it does not matter on which side 
you put the connector. For more information   on the connectors, see section “Oqus 
connectors” on the next page.
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System setup

Note: When the cables have been connected   correctly the LEDs on the back of the 
Oqus will be lit. The EXT   LED will be lit green and the ACT   LEDs will be blinking.

However, the connection of the power adapters does require   some attention. One power 
adapter can power up to 4 Oqus cameras. Therefore,   the connection of a camera system 
comprising of more than four cameras   must look something like the image below.

This means that you must use the following cables for   an 8 camera system:

1 host cable between computer and camera.

6 bundled cables with power and data.

1 data cable connected between camera 4 and 5   in the setup, because one AC/DC 
adapter can only power 4 cameras.

2 AC/DC adapters, connected to for example camera   1 and 5.

 Note: For more detailed information about the Oqus system, please refer to the QTM 
manual or the Oqus setup guide.

Oqus connectors
The back of the camera holds six connectors for power,   data and control connections. 
The view differs slightly depending on the   type of camera. The image below shows the 
standard version of the camera.   The water protected version uses different connectors 
and lacks the LEDs   found on the standard version.
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 1. Left Data port, Right Data port   (light blue)
Ethernet connector. 100BaseTX/802.3i, 100 Mbps, Fast Ethernet. The two   
ports are identical.

 2. Left Ethernet activity indicator,   Right Ethernet activity indicator
Shows the status of the Ethernet connection. Fixed green light means that   a 
carrier signal has been detected and that the connection is up. Flashing   green 
light indicates that data is received and/or transmitted. 

 3. Battery port (white)
Used to supply the camera with power from an Oqus compatible battery.

 4. Battery status indicator
Lit green when the camera is supplied though the BATTERY   port.
Lit red when a voltage outside the specified range (10-16V) is connected   to 
the port.

 5. Power supply status 
Lit green when the camera is powered through one of the POWER   ports. A 
red light indicates internal power supply error. 

 6. Left power supply port, Right   power supply port (black)
Daisy-chain power port. Supplies the camera with 48VDC and can be daisy   
chained to supply cameras further down the chain with power. The ports   are 
identical there is no specific in-port or out-port.

 7. Control port (light grey)
The control port is used to synchronize the camera with external sources,   and 
contains pins for e.g. external trigger in, external sync in and external   sync 
out. Splitter cables are needed to connect one or more BNC cables   to this 
port.

 8. Camera identification
This label provides information on:

- The serial number of the camera
- The product number
- The Ethernet Mac address
- The WLAN Mac address 
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System setup

Oqus camera display
The Oqus camera has a large graphical OLED display and   three LEDs on the front to 
inform the user of the current status of the   camera. The display shows, among other 
things, the camera number and the   number of markers currently seen by the camera.

 Note: The display will be turned off   when the camera enters stand-by mode, i.e. if the 
camera has not been   in use for 2 hours. Start a preview in QTM to light up the display 
again.

 1. Measurement status indicator
Green light - The camera is ready to start a measurement
Yellow light - The camera is measuring
Flashing green light - Waiting for trigger to start measurement
Flashing yellow light - Waiting for trigger to switch from pre-trigger   to post-
trigger measurement

 2. Error indicator
A red light indicates that an error has occurred. The LED is blinking when   a 
software error occurs and is lit constantly if a hardware error occurs.

 3. IR receiver
The IR receiver is used for synchronization with certain active markers.   It 
detects modulated light with a frequency of 33 kHz and is sensitive   to light 
with wavelengths between 800 and 1100nm.

 4. Synchronization status
During the synchronization phase this symbol is flashing. When the camera   
is synchronized with the master camera in the system it becomes stable.

 5. WLAN indicator
This symbol is displayed when the WLAN of the camera is activated.

 6. Master/Slave indicator
An M indicates that the camera is master for the system and by that controls   
for example internal synchronization. An S indicates that the camera is   a 
slave. The indicator can also be a rotating + sign, which means that   the 
camera is looking for the Master camera.
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 7. Camera number
The area to the right usually shows the camera number that the camera has   in 
QTM. The camera number can be changed with the Reorder   tool in the 2D 
view window. This number is stored in the camera so it   is shown at the next 
camera startup.

 Note: If the camera has never been connected   to QTM the last three digits 
of the serial number (upper part) and the   last octet of the IP-number assigned 
to the camera (lower part) will be   shown instead. This can also be activated 
from the QDS menu, see “QDS” on page 14.

 8. Marker area
During a marker measurement this area shows the number of markers 
currently   seen by the camera. When the camera is idle or is collecting video, 
this   area shows ’-----’.

 9. Text area
This area is used for scrolling text messages, for example during startup.

Setting the aperture and focus (Oqus)
For Oqus it is very important to set the aperture and   focus correctly for your 
measurement volume. If these are not set correctly   the cameras will not reach their full 
potential in detecting markers.   Follow this procedure to set the aperture and focus. 

 1. For cameras with manual lens control, turn the strobe part of the camera 
counterclockwise to expose the   lens for adjustment. For Oqus 7+ cameras 
with motorized lenses the aperture and focus can be controlled in QTM via 
the Lens Control interface in the Camera Settings sidebar in the 2D View 
window (see "Camera settings sidebar" in the QTM manual).

 2. Set the aperture. The recommended value is 2.8 (or the lowest value if 2.8 is 
not available). 

 Note: If a larger focal depth is needed, the aperture can be set at a higher 
value. You can use the Marker intensity mode in the 2D view in QTM to 
check if the markers are bright enough. Note that by increasing the aperture 
by one f-stop (e.g., from 2.8 to 4) the light intensity is reduced by half.

 Note: At larger distance a lower aperture value may help to increase the 
light intensity of the markers. However, note that this may lead to 
deformation of the markers, especially in the vicinity of the corners.
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System setup

 3. Place a marker in the measurement volume. Use the same size as   will be used 
in the actual measurement.

 4. The focus is then best set either in Marker or in Video mode. 

 a. For Marker mode, make sure that you can only see the marker that you 
have placed in the volume. Then open the Data info window and plot 
the x-size of the marker. Change the focus until the x-size is as small as 
possible.

 b. For Video   mode, change the focus until the marker is as small and sharp   
as possible. Make sure that the Flash   time is long enough in the 
Camera settings sidebar.

Note: The 4-series camera can only show the video image in 1/4 
resolution.

 5. When you have set the focus correctly, switch to Marker   intensity mode in 
QTM to make sure that the markers are visible   in Marker mode. If the color 
of   the markers is not red, set a longer marker exposure time in the Camera 
settings sidebar.

 6. Turn the strobe back (clockwise) to close it. The strobe should   always be 
closed during measurement, to achieve the best strobe light   distribution.

Setting up a Miqus system
             A basic Miqus system consists of the following components:

 l Miqus cameras (2-10 cameras)

 l Miqus camera cables (data/power)

 l A power kit (Miqus power supply, power injector, host cable)

 l Optionally: a Miqus Sync Unit

The Miqus system is easy to set up. The backside of the camera contains two 
data/power ports. In a basic setup with up to 10 cameras, the cameras (and, optionally, a 
Miqus Sync Unit) are connected to each other by Miqus camera cables in a daisy chain 
configuration (see illustration below). The first camera of the chain is connected to a 
power injector (Camera port), which in its turn is connected to the power supply 
(Power port) and to the computer via a host cable (Data port).
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In larger systems with more than 10 cameras, the use of one or more additional power 
supplies is required. A maximum of 10 cameras and 1 Miqus Sync Unit can be 
connected to a single power supply. Larger systems are configured as follows (see 
illustration below). Every 10th camera in a chain is connected with a host cable to a 
power injector (Data port). The additional power supply is connected to the Power port 
at the power injector, and the Camera port is connected to the 11th camera in the chain 
with a Miqus camera cable.

Note: For large camera systems (e.g., more than 16 cameras) it is recommended to 
setup the system with a Gigabit Ethernet switch.
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System setup

When the cables have been connected correctly, the indicator LEDs at the Miqus 
data/power ports will be lit as indicated in the illustration below. For more information 
about the connectors and the function of the indicators, see the Sections “Miqus camera: 
front side” on the facing page and “Miqus camera: back side” on page 12.

 Note: For more detailed information about the Miqus system, please refer to the QTM 
manual or the Miqus setup guide.
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Miqus camera: front side

 1. LED ring
LED ring for camera identification and indication of status during startup 
sequence.     

 o Green light: Active camera indicator (see “Identifying the cameras 
(Miqus)”)

 o Pulsing green light: Camera system being calibrated

 o Amber light: Camera is booting

 o Pulsing amber light: Camera is waiting for IP address

 2. Measurement status indicator

 o Green light: The camera is ready to start a measurement

 o Yellow light: The camera is measuring

 o Flashing green light: The camera is synchronizing to the master camera

 o Flashing red light: Error signal

 3. Lock lever

 o Lock/unlock the strobe mechanics
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System setup

Miqus camera: back side

 1. Left daisy-chain data/power port
Combined Power/Gigabit Ethernet connector.

 2. Right daisy-chain data/power port
Combined Power/Gigabit Ethernet connector.

 3. Left port Link/Activity indicator
Shows the status of the ethernet connection. Fixed yellow light means that a 
carrier signal has been sensed and that the connection is up. Flashing yellow 
light indicates that data is received and/or transmitted.

 4. Right port Link/Activity indicator
Identical to left indicator.

 5. Left port Gigabit link indicator
Lit orange when Gigabit Ethernet link is established.

 6. Right port Gigabit link indicator
Identical to left indicator.

 7. Left port Power indicator
Lit green when the camera is powered on.

 8. Right port Power indicator
Lit green when the camera is powered on.

 9. Camera identification
This label shows:

 o The serial number of the camera

 o The product number

 o The Ethernet Mac address

 10. Kensington Security Slot
Slot for connecting a security cable.

12



Setting aperture and focus (Miqus)
It is very important to set the aperture and focus correctly for your measurement volume. 
Incorrect settings might lead to sub-optimal marker detection by the cameras. It is 
recommended to use the following procedure for setting the aperture and focus.

 1. Select the camera in the 2D view window in QTM using the Camera 
selection bar or by double clicking on the image area.

 2. Unlock the strobe on the Miqus camera and shift it outwards to expose the 
lens for adjustment.

 3. Set the aperture. The recommended value is 2.8. For the Goyo 6 mm lens 
(standard on the Miqus M1) this is at the middle of the aperture ring (screw 
hole should be aligned with the dot).

 Note: If a larger focal depth is needed, the aperture can be set at a higher 
value. You can use the Marker intensity mode in the 2D view in QTM to 
check if the markers are bright enough. Note that by increasing the aperture 
by one f-stop (e.g., from 2.8 to 4) the light intensity is reduced by half.

 Note: At larger distance a lower aperture value may help to increase the 
light intensity of the markers. However, note that this may lead to 
deformation of the markers, especially in the vicinity of the corners.

 4. Place a marker in the measurement volume at the position which needs to be 
in focus. Use the same marker size as used for the actual measurements.

 5. The focus can be best set in Marker or in Video mode.

 a. In Marker mode, make sure that you can only see the marker that you 
have placed in the volume. Then open a Data info window and plot the 
x-size of the marker. Change the focus until the x-size is as small as 
possible.

 b. In Video mode, change the focus until the marker is as small and as 
sharp as possible. Make sure that the Flash time is long enough in the 
Camera settings sidebar. You can also zoom in and translate the 2D 
view for better detail.

 6. When you have set the focus correctly, switch to Marker intensity mode in 
QTM to optimize the marker settings Exposure & Flash time and Marker 
Threshold. For more information, see “Marker settings” on page 44.
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 7. Shift back the strobe towards the lens and lock the strobe with the lock lever. 
You may have to fine adjust the position of the strobe so that the lock lever 
locks into the dimples on the strobe rails.

 Note: Make sure that the strobe is mounted with the dimples on the strobe 
rails pointing up (see also the "up" sticker on the side of the strobe for the 
correct orientation). The lock lever must be in unlocked position when 
inserting or moving the strobe unit.

QDS
QTM comes with a DHCP server called QDS (Qualisys DHCP   Server), which distributes 
IP addresses to the Qualisys cameras. An IP address   for each camera is required to be 
able to communicate with them over the   Ethernet network. QDS will be installed 
automatically with QTM and it   must be running at all times, to provide the cameras 
with IP addresses   at startup. The DHCP server will only give IP addresses to Qualisys 
cameras   so it will not disturb your computer network.

QDS includes a wizard to configure network interfaces   to use them with Qualisys 
cameras and to activate wireless operation on an   Oqus camera.

QDS menu
To open the QDS menu, right-click on the QDS icon    in the status toolbar.

The following are the   most important options on the QDS menu:

Configuration   wizard
The configuration wizard can be used to setup your network interface   for Qualisys 
cameras, to configure an Oqus camera for wireless operation and to setup a virtual 
wireless access point.

Advanced
Advanced configuration of network   interfaces on the computer.

Network configurations
Using this sub-menu you can save or load network configurations. Click   on Save 
to save the current configuration   and then to load a configuration click on Load.

Network configuration wizard
The QDS network configuration wizard will guide you   through the different steps to 
setup the network for Qualisys cameras. Follow   the steps below.
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 1. Click on Configuration wizard   in the QDS menu to start the wizard.

 2. Select Configure a network interface...   and click Next.

 3. The list will show all enabled network interfaces on the computer.   Select the 
interface that you want to use with Qualisys cameras and click   Next.

 Note: The wizard will not configure   all interfaces, for example a network 
interface that is already connected   to an internal network and has received an 
IP address will not be configured   because it is considered to have a running 
DHCP server. However, any disconnected   interfaces can be configured by the 
wizard.
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 4. The wizard shows how it will change the selected interface. You   can save 
the current network setup with the Save   button for backup. Click Next   to 
continue.

 5. Click Finish to close the   wizard.

Connecting other hardware
Other hardware that can be connected to QTM includes   analog boards, force plates and 
EMG. For description of how to do this   and for the settings that need to be set, please 
refer to the QTM   User manual.
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QTM user interface

QTM user interface and windows
The QTM user interface and windows are flexible and user-friendly.   There are many 
features available in QTM and below you will find the main   features described.

 1. Menus
From the menus you can reach all of the features in QTM.

 2. Toolbars
The toolbars contain buttons for the more frequently used features. The   most 
important buttons are:

New file 

Project options 

Start capture 

Reprocess file 

Apply AIM model 

Generate AIM model 

 3. 3D view window
The 3D view window displays the captured data in 3D. The data can also   be 
edited by using the different tools in the 3D   view toolbar

 4. 2D view window
The 2D view window displays the captured data in 2D for each camera. In   
RT/preview mode there is also a Camera   settings sidebar where you can 
modify the camera settings. There   are also some tools in the 2D view   toolbar 
for modifying the camera in RT/preview mode. At the bottom of   the window 
there are buttons to select which cameras that are displayed.

 5. Trajectory info windows
The Trajectory info windows contain   the tracked 3D data.
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QTM user interface

 6. Project view
The Project view displays all of the files in the Data folder of the project.

 7. Data info window
The Data info windows can display   the following data: 2D, 6DOF, Analog, 
Force and Gaze vector.

 8. Plot window
Any of the data in the Trajectory info   windows and the Data info window   
can be plotted. 

 9. Timeline toolbar
The Timeline toolbar controls the   position in a file.

Projects
QTM needs a project to capture measurement data. The project is a folder that contains 
all the files and information needed for QTM to process the data. A project can therefore 
be easily transferred to for example another computer with all the settings and files 
needed for the processing. To create and use projects follow the instructions in the 
chapters below.

Using projects
The following sections describe some typical use scenarios and recommendations  on 
how to use projects. However, projects can be used in many different ways, depending 
on how you want to organize and share your settings.

Think about the following when deciding how to use the projects.

 1. When to create a new project.

 a. It is usually recommended  to use one project per marker setup. Then you 
can save different subject in sub-folders of the project data folder.

 b. You may of course create any amount of projects based on for example 
the people using the lab.

 2. Settings to use when creating a new project, see chapter “Creating a new 
project” on page 21 and “Project presets” on page 26.

 3. It is recommended to save all of the measurement in the project data folder, 
because then you can browse them in the Project view window, see chapter 
“Project view” on page 23.

 4. Do you want to backup settings, see chapter “Backup of project settings” on 
page 26.

 5. Do you want to view the list of recent projects at startup or always open a 
certain project, see chapter “QTM startup procedure” on page 20.

Read the following sections for advice on specific setups: “Projects with qualified 
users” below, “Projects with students” on the facing page and “Using projects on 
multiple computers” on the facing page.

Projects with qualified users
For qualified users, projects are helpful to manage the settings of multiple projects or 
studies. Below follow some suggestions. 
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 1. Create a new project when there is a new study, with a new marker setup.

 2. Save all of the QTM files in the project data folder as you can then browse 
the data in the Project view in QTM, see chapter “Project view” on page 23.

 3. Make a backup of the project settings if you like to be sure that you can 
always go back to the settings you know are correct, see chapter “Backup of 
project settings” on page 26. If someone opens the project any changes they 
do to the settings are saved automatically.

 a. If you want to completely protect your projects from other users it must 
be done via Windows, for example by having multiple logins to the 
computer.

 4. Pin projects that are often used in the Open project dialog, see chapter 
“Manage projects” on page 22.

 5. Create a Project preset if you create a lot of new projects and want to use 
the same settings when it is created, see chapter “Project presets” on page 26.

Projects with students
When working with students using QTM, projects can be used as follows. 

 1. Create a Project preset so that the students can start with the same settings, 
see chapter “Project presets” on page 26.

 2. Tell the students to create a new project with the Project preset and save 
them at a specific place. The default folder is Documents in Windows, but it 
can be changed, see chapter “Folder options”  “Folder options” in the QTM 
user manual.

 a. It is a good idea to use a different Windows login for the students so 
that they cannot access other projects.

 b. If the students can access the other projects make sure that you backup 
the settings of the projects, see chapter “Backup of project settings” on 
page 26.

 3. Make sure that the QTM files are saved in the project data folder. It is the 
default path if nothing has been changed in the project settings.

Using projects on multiple computers
If you use a project with different camera systems you can either move the whole 
project (or computer) or just move the Data files and AIM models.

 l It is recommended to setup the project on both computers and just move the 
Data and AIM files. Because then there is no risk for losing settings, on the 
other hand you have to remember to change the settings on both places if 
you need to.

 o If you move the whole project, then you need to decide on how to 
handle the camera settings. QTM will automatically detect on New if 
the cameras have changed and you will get the option to import all the 
settings from another project. It is important to notice that it will 
overwrite all the settings in the current project, so you will need to add 
any settings that differs again, for example the AIM model.

Note: If you locate the system first, QTM will not give a warning for a 
new camera system, because it is seen as you then wanted to check for a 
new system.

19



QTM user interface

 o If you just move the Data files there is no problem in opening them on 
the other computer, because all of the information needed to reprocess 
the file is included in the file.

QTM startup procedure
The first time you start QTM on a new computer you will get a question about creating 
a project.

There are three ways to start QTM when you have not used projects before.

Create project
This is the default option because you must have a project to capture data in 
QTM, see chapter “Creating a new project” on the facing page.

Open project...
Use this option to open a project folder that has been copied from another 
computer.

No project
If you only want to open QTM files you can start QTM without a project, but 
you will not be able to capture any data or change any project options.

After using projects the first time the default startup procedure for QTM is to display the 
Manage projects dialog. Each time you start QTM you have to select the project to 
load, to make it less likely that someone make changes in a project by mistake. For 
more information about the dialog see chapter “Manage projects” on page 22.
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It is also possible to choose to open the most recent project or a selected project when 

starting QTM. To set these click the  button, see chapter “Startup” in the QTM 
user manual.

 Note: QTM will use the latest calibration made on the computer, that was made with 
the same cameras (placed in the same order). It means that the calibration may be loaded 
from another project when switching projects, it is then copied to the Calibrations folder 
in the project folder.

Creating a new project
A new project is created with the New project option on the File menu or in the Switch 
project dialog. The following  dialog is opened with options to create a new project.

Enter the following information to create the project

Project name
The project name will also be the name of the project folder . The folder is 
created automatically if it does not exist at path specified in Root folder path.

Note: To change the project name after it has been created use the Rename 
Project option on the File menu.

Project folder path
This is the path of the project folder. The default is the Documents folder in 
Windows. Click Browse to change the path.

Note: The Default path for new projects can be set on the Folder options page 
in the Project options dialog. 

Note: If you want several computer users to access the same project, it must be 
saved in a folder which all users have access to. For example on Windows 7 you 
can use the folders of All users.

Base the new project on:
Select the source of the settings that are used when creating the project with the 
drop-down box.

Custom preset: ...
Any project presets available on the computer are displayed at the top of the 
list, for more information about the presets see chapter “Project presets” on 
page 26.

 Note: QTM will use the latest calibration made on the computer, that was 
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made with the same cameras (placed in the same order). It means that the 
calibration may be loaded from another project when switching projects, it is 
then copied to the Calibrations folder in the project folder.

The current settings
The settings are copied from current settings in Project options. This is the 
default option when creating a project with the New project option on the 
File menu.

Note: There is no current project when you start QTM therefore the default 
option is then Settings imported from another project.

Settings imported from another project
Browse for the project that you want to base the new project on and open the 
project file.

Default settings
All settings are set to the default values and all of the current settings are 
deleted.

IMPORTANT: If you select any of the options other than the Current settings, you 
will lose the current settings in Project options. If you haven't got any projects in the 
recent projects list, then the settings are saved in a backup in 
C:\ProgramData\Qualisys\Workspace backups.

Manage projects
Use Manage projects on the File menu to manage the projects, for example to switch to 
a recently used project or open another project. When switching project all of the 
currently open files will be closed and you have to save any unsaved files. Then the 
settings in Project options and other settings such as those in the Start capture dialog 
are loaded in QTM from the new project.

 Note: QTM files outside the project can still be opened and processed if you like. 
QTM will then note that the file is not in the current project in the title bar.

 Note: QTM will use the latest calibration made on the computer, that was made with 
the same cameras (placed in the same order). It means that the calibration may be loaded 
from another project when switching projects, it is then copied to the Calibrations folder 
in the project folder.
The calibration is also checked if the cameras are changed at Locate or New. If there is 
a matching calibration for the new cameras it will be loaded in the project.

The list in the Manage projects dialog displays the 100 most recently used projects. 
Double-click on a project to open it. You can pin  projects so that they are always on 
the top of the list, you have to click Open for the pinning to change. 
The current project is shown when with [Current project] next to the name. The current 

22



project is also displayed in the title bar of QTM and Project options.
Note: When QTM starts up there is no current project, since it has not been loaded 

yet.

The following options are available in the dialog:

Browse
Use this option to open a project that is not in the list above, e.g. one copied from 
another computer.

New project
Create a new project, see chapter “Creating a new project” on page 21.

Open settings for the startup of QTM, see chapter “Startup” in the QTM user 
manual.

Open
Open the project selected in the list above.

Project view
The Project view window displays the data files included in the current project. The 
view consists of two parts: Project data tree and Details . The name of the current 
project is displayed at the top of the Project view.

To open the Project view window go to View menu and select Project view, the 
shortcut to toggle the window is ctrl+r.

Project data tree
The Project data tree window is used to display and open the files in the Data folder of 
the current project. This includes folders and QTM files, but also all other files. You can 
drag and drop files to the Project data tree from for example Windows explorer. If the 
file is dragged from another folder on the same hard drive it is moved to Data folder. 
You can toggle whether to copy or move the file with the CTRL key. If the file is on 
another hard drive or the network then a new copy is made in the Data folder.

The data tree can be searched with Find (Ctrl+F) on the Edit menu. When searching the 
first occurrence of the search term will be highlighted in the data tree. Use Find Next 
(F3) to search for the next occurrence of the current search term. 

23



QTM user interface

There are two commands at the bottom of the data tree: Add (New folder or New 
measurement) and Open. 

When adding a folder it is placed in the currently selected folder, if none is 
selected it is placed in the root of the Data folder. Adding a new measurement is 
the same as starting a new capture with the Capture command on the Capture 
menu and the folder to save the file in is set to the currently selected folder in the 
project view.

The Open command is only available when a file is selected and it will then open 
that file. If it is a QTM file it is opened in the current QTM window or a new 
window, depending on the current settings on the GUI page in Project options. 
Other files are opened with its corresponding Windows program.

The QTM file that is open in the current QTM window is displayed in bold. If you 
open a file that is already open in another QTM window you will switch to that 
window.
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Right-click on a file or a folder to get the following options.

Open (only available for files)
Opens the selected file in QTM if it is a QTM file. Otherwise it is opened by its 
corresponding Windows program.

Open in New window (only available for QTM files)
Opens the QTM file in a new QTM window. It overrides the Close current file 
option on the GUI page.

Open folder in explorer
Open the currently selected folder in Windows explorer so that you can for 
example move the files.

Rename
Rename the selected file or folder.

Batch Process...
Batch process the currently selected files. It will open the Batch processing 
dialog so that you can select which processing steps that you want to apply, for 
more information about batch processing see chapter “Batch processing”.

Delete
Delete the selected file or folder.

Add

New folder
Add a new folder in currently selected folder. If no folder is selected it is 
placed in the root of the Data folder.

New measurement
Add a new measurement, which is the same as Capture on the Capture 
menu and the folder to save the file in is set to the currently selected folder 
in the project view.

Refresh
Refresh the content in the Project data tree so that it matches the content of the 
project data folder. This is usually done automatically by QTM.

Details

The Details window displays information about the currently selected file. The 
displayed data is:

File name

File type

File size
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File created
This is not the time when the data was captured, but when the file was created on 
the computer which is not the same if the file has been copied.

File modified

Full path

Backup of project settings
The project settings can be saved in a backup file. The backup can then be used if you 
want to use two different sets of settings in the same project or if you want to be sure 
that the settings are not changed by someone else, because the project settings are saved 
automatically when they are changed in QTM. Click on Settings backup and restore in 
the File menu to create and manage the backups.

Backup
Enter the Backup name and click Create backup to save a backup of the current 
settings in Project options.

Restore
The list displays all of the backups saved in the current project. Select one and 
click Restore backup to copy the settings to Project options.

Note: The current settings in Project options will be replaced.

Note: QTM will use the latest calibration made on the computer, that was made 
with the same cameras (placed in the same order). It means that the calibration 
may be loaded from another project when switching projects, it is then copied to 
the Calibrations folder in the project folder.

Project presets
The project presets can be used when creating projects to make sure that you start with 
the same settings. The project preset contains all of the settings QTM (Project options 
and other settings such as those in the Start capture dialog). The preset also contains any 
AIM model that was in the project AIM folder when creating the preset.

Note: The presets are saved globally, in the folder 
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C:\Users\????\AppData\Roaming\Qualisys\Project presets\, so that it can always be 
accessed when creating projects in QTM.

To create a preset follow these steps.

 1. Open a project with the settings and AIM models that you want to use.

 2. Go to the File menu and select Settings management/Project presets to open 
the Project presets dialog.

 3. Enter the name of the preset and click on Create preset.

To use a preset follow these steps.

 1. Go to the File menu and select New project.

 2. Enter a Project name and select the settings to Base the new project on from 
the drop-down list. The presets are listed as Custom preset: followed by the 
name.

If you want to change any settings in a preset you need to create a project with the 
preset and then change the settings. Then create the preset again with the same name.

A preset can be deleted from the Project presets dialog. It is important to notice that the 
presets are deleted from the computer so that it can no longer be accessed by anyone.

Project folder
The project folder  is used for organizing a QTM project. The folder is displayed in 
Windows explorer with a special icon  to indicate that it is a QTM project folder. It 
contains the following files and folders:

Data
This is the default location for the captured QTM files. You can create subfolders 
in this folder if you want to sort the files, for example for different subjects.

AIM models
This folder contains all of the AIM models created in the current project.

Calibrations
This folder contains all of the calibrations made in the current project.

Labels
This is the default folder for Label lists.
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Messages
This is the folder for the messages log files.

Settings
This folder contains the backups of project settings.

Settings.qtmproj
This file contains the current settings of the project.

Note: The project file may change format with a new version of QTM. A 
backup is saved of the previous version of the file, it can be named for example 
Settings.qtmproj.ver_100-101.

Note: The project file in before QTM 2.9 was called settings.qps. A backup 
(.bak) is saved of this file when it is converted to the qtmproj format.

QTM creates a default project folder called Qualisys in My Documents when installing 
QTM on a new computer. However you can create a new project folder anywhere. For 
example if you want different users on the computer to access the same project it can be 
saved under the Public user in Windows 7. Copy the whole folder if you want to share 
the project with someone else.

There are other settings and files which are needed for all users that use QTM on a 
computer. To see where these are saved check the Folder options page in the Project 
options, see chapter “Folder options”. 

   Note: The QTM program and other components installed by the QTM installer   are 
placed in Qualisys Track Manager folder under \Program Files\Qualisys   (\Program Files 
(x86) for Windows 64-bit operating systems).

RT(Preview)/File mode
The QTM software has two modes of operation: RT (preview)   mode and file mode.

The RT (preview) mode is entered when a new file is opened   in QTM. Click on New on 
the File menu to open a new file or use the keyboard shortcut Ctrl+N. In RT   (preview) 
mode the motion capture is shown in real-time before and during   a measurement. In RT, 
the data can also be accessed via a real time TCP/IP   protocol.

The file mode is used when the motion capture is finished.   Manual editing of a QTM 
file can only be done in file mode.
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2D view window and features

The 2D view window displays the raw data of all cameras connected to QTM. This   
includes 2D views of the motion capture data from each camera in the measurement   
system. It also includes Oqus video that are displayed in the 2D view   of the Oqus 
camera and the DV/webcam video which is displayed after the Qualisys cameras.

The 2D view window includes the following   controls:

2D view toolbar
Contains tools for the 2D view. The first three are for select, zoom and   translate. 
Furthermore, there are three tools for FOV, camera masking and   camera order. Use 
these to change the image size, place marker masks to   cover unwanted markers 
and for rearranging the order of the cameras. The auto-exposure tool can be used 
for Oqus color video cameras to modify the area of the sensor used for auto-
exposure. Finally, there is a tool for identification of Miqus cameras and a tool for 
toggling 3D overlay.

Camera selection   bar
Select the cameras that you want to view in the 2D view window. When 
changing   the settings on the Camera settings sidebar it only affects the currently   
visible cameras.

Camera settings   sidebar
Control the basic settings of the cameras.  With the camera settings sidebar you 
can change   Exposure time and Marker   threshold. Use these settings during the 
setup of the system, see   section “Marker settings” on page 44.
With the Mode options you select   how to view the image from the camera during 
preview.

Markers
In this mode the cameras calculate the position of the markers.

Marker intensity
This mode shows a color coded image of the marker calculation and is useful   
when changing the camera settings.
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Video
This mode shows the video image from the camera. If you want to capture   
video instead of markers from a certain camera, set it to video mode before   
starting the capture.

2D view window   menu
Right-click to open options for a single camera. Among   other things you can 
rotate the 2D view to match the physical setup.

The following objects are displayed in a 2D view for   a camera:

 l The number in the lower left corner of the 2D view of a camera   is the camera 
id. A motion capture camera is displayed as for example   #1, and a 
DV/webcam camera is displayed as for example #1V.

 l The number in the lower right corner is the current number of markers   seen 
by the camera. A 'V' is displayed instead, if a motion capture camera   is in 
video mode.

 l The current Image size   of the camera is shown as a red square and the part of 
the image that   is outside the image size is greyed out. For Oqus cameras the 
Image   size can be changed with the Image   size tool on the 2D view   toolbar, 
see chapter “2D view toolbar”.

Note: In a file, only the active part of the sensor is displayed. I.e. if the 
Image size of the Oqus has been reduced, then the aspect ratio of that 2D 
view will match the reduced image size.

 l For Oqus the marker masks are shown as green squares, see chapter “How to 
use marker masking”.

 l The Oqus video is also shown in the 2D view window, both in preview   and 
in a file. This means that all of the actions, like zoom and 3D overlay,   can be 
performed both in preview and in a file. How to capture video from   Oqus is 
described in the chapter “Oqus video capture”.

Note: In a file, only the active part of the video image is displayed. I.e. if 
the Image size of the Oqus has been reduced, then the aspect ratio of that 
video view will match the reduced image size.

 l The external video devices are displayed after the motion capture cameras   in 
the 2D view window. You can use zoom on the video in both preview and   
file mode. The video cameras will appear in the same order as they are   on the 
Video devices page in the   Project options dialog. For   more information 
about video devices see chapter “External video devices in 2D view”.

 l The 2D markers are color coded when marker filtering is activated   on the 
Oqus camera, see chapter “How to use circularity filtering and correction of 
merged markers”.

 l There is a red warning sign  in the top left corner if the camera has   
problems calculating the markers. Hover the mouse over the warning sign   to 
get more information.
The most common problem is that the camera does not have time to calculate   
all of the markers. This is actually caused by too much background light.   If 
this happens, reduce the Exposure   time or increase the Marker threshold.  

 l If the markers are grey and it says Not   used for tracking in the middle of the 
view, that camera has been   deactivated on the Linearization   page in the 
Project options   dialog.
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 l The delayed exposure setting is displayed next to the camera number,   e.g. 
expgrp: 1 when the camera   is in exposure group 1.

3D view window and features

In 3D view window the motion capture data is shown in 3D using the coordinate   
system that was defined in the calibration.

The 3D view window includes the following controls:

3D view toolbar
Contains tools for the 3D view, for example Center   trajectory and Quick 
identification.

3D view window   menu
Options for the 3D view, opened by right-clicking in the 3D view window.

The following graphics can be shown in a 3D   view window:

 l Axes of the coordinate system of the motion capture (X = red, Y   = cyan and 
Z = dark blue).

 l A grid showing the floor of the measurement volume (e.g.   Z = 0, if Z is the 
vertical axis of the measurement setup).

 l The position and orientation of each camera in this specific setup.
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 l Text labels for some of the graphics.

 l Markers for the current position of the trajectories.

 l Traces of the trajectories.
 Note: Only available in file mode.

 l Bones between markers.

 l 6DOF bodies.

 l Rectangular areas showing the location of the force plates.

 l Force vectors (red) displaying the current force on the force plate.

 l A blue force trace displaying the force applied to the force plate   during the 
measurement.

 Note: Only available in file mode.

 l Camera view cones.

 l Covered and calibrated volumes.

 l A white outlined box for the bounding box used by the 3D tracker.

All of these graphics can be toggled on and off and changed   on the 3D view settings 
page in   Project options dialog.

Change the viewpoint of the 3D view
The 3D view can be rotated, translated or zoomed so that   the data can be seen from the 
viewpoint that you want. For most actions   which change the view of the 3D view a red 
crosshair  is shown indicating the center of the 3D view.   By double clicking 
anywhere in the background, the center is automatically moved to the geometrical 
center of all 3D points at the current frame.

The following actions can be performed in 3D   view windows to change the view of the 
3D view: 

Rotate the 3D view
Hold down the left mouse button in the 3D view window and move the mouse,   
the view is rotated freely around the red crosshair. Hold down Ctrl +   Shift to limit 
the rotation to the current plane of view.

Translate the 3D   view 
Hold down the right mouse button in the 3D   view window and move the mouse, 
the focus is moved in the 3D   view.
Another way to move the focus is to hold down Shift+C and click on a trajectory   
then the focus is moved to that marker.

Zoom in/out the   3D view 
Hold down both mouse buttons in the 3D view window and move the mouse   
backward and forward. The view is zoomed out and in respectively, in reference   
to the position of the red crosshair. The mouse wheel can also be used   to zoom. 
You can also zoom to the current position of the mouse cursor   by holding down 
Ctrl.

 Note: With the mouse buttons the zoom   is continuous, while with the mouse 
wheel it is done in steps.
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Trajectories in 3D views

The trajectories of a measurement are shown with markers   on their current position in 
the 3D view, where the colors of the trajectories   are the same as in the Trajectory info   
windows.  The data of the   marker is shown in a Trajectory info   window, see section 
“Trajectory info windows and menu” on the next page.

In file mode, the position throughout the measurement   can be displayed with a trace, 
where the length of the traces is controlled   by the bottom sliders on the Timeline 
control bar. The trace of   a trajectory is thicker when the focus is set on its trajectory in 
the   Trajectory window, i.e. there is a dashed box around it.

The following section describes some of the actions that   can be performed on 
trajectories. For more information about the actions,   see the QTM User manual. 

Select
Click on the marker or the trace of the trajectory to select it. Use the   following 
keys to modify the action when you click on a trajectory.

Hold down Alt to only select a part of the trajectory.   

Use Shift and Ctrl to add and delete (only Ctrl)   trajectories to the selection.

Hold down Shift and drag the mouse   to use area selection.

Drag and drop for identification of trajectories
Trajectories can be drag-and-dropped from the 3D view to labeled trajectories to 
change their identity. For   example, drop an unidentified trajectory from the 3D 
view onto an empty label in the Labeled trajectories window to identify   it. In 
case the labeled trajectory is not empty, this requires that there is no overlap 
between the trajectories. 

A trajectory can also be dropped on the trace   of another trajectory in the 3D view 
to join them. This can be used in combination with scrubbing (hold down 
Control and drag the mouse in empty 3D space) and trace range zooming (hold 
down Shift and roll mouse wheel).

 Quick identification   
The quick identification method provides an easy way to manually identify the   
markers. First select an empty label. Then hold down Ctrl+Alt or select   the Quick 
identification cursor   to activate this method. Then click on a marker and it will be 
identified   as the currently selected empty label in the Labeled   trajectories 
window. For more information about quick identification,   see section “Manual 
identification of trajectories” on page 59.

 Create bones
To create a bone, hold down Shift and select a pair of labeled trajectories   by 

33



QTM user interface

clicking in the 3D view window. Then press 'b' and there will be bone   between 
the pair. Several bones can be created with the Create bones sequence tool.

 Center on trajectory   
Select a trajectory and press 'c' to change the viewpoint so that it centers   on that 
marker. You can also use the Center   trajectory cursor and click on the marker.

6DOF bodies in 3D views

Measured 6DOF bodies are displayed as separate local   coordinate systems in a 3D view 
window, where the origin is placed   at the position of the local origin of the 6DOF 
body. The axes of the   local coordinate system have the same color codes as the 
coordinate system   of the motion capture.

Virtual markers corresponding to the points of the 6DOF   body definition are also 
displayed for each 6DOF body. The markers will   therefore be displayed with two colors 
in the 3D view. The colors of the   rigid body are set for each 6DOF body definition on 
the 6DOF   trackingpage   in the Project option dialog. The actual trajectories will 
automatically   get a slightly brighter color.

Place the mouse over the local coordinate system to see   information about the body in 
the current frame.

Trajectory info windows and menu
The trajectories of the measurement are listed in the   Trajectory info windows. The 
following three Trajectory info   windows are used in QTM:

Labeled trajectories window 
Contains the trajectories that have been identified (labeled).

Unidentified trajectories window 
Contains unidentified trajectories. 

 Note: After a motion capture the trajectories   are placed by default in the 
Unidentified trajectories window,   as long as identification is not performed in 
the automatic processing.

34



Discarded trajectories window
Contains trajectories that have been manually deleted.

By default the Trajectory info windows are placed   on the right side of the main 
window. However they can be moved to any   position. 

The options for the trajectories are found on the Trajectory   info window menu, which 
is opened by right-clicking on a trajectory   or a group of selected trajectories. When 
multiple trajectories are selected   the options on the menu is applied to all of the 
trajectories.

Data in Trajectory info windows

The following data is listed in all of the Trajectory   info windows:

Trajectory 
The label of the trajectory and the color of its marker in 3D views. In   addition to 
the color the symbol next to the label also shows if the trajectory   and its trace are 
displayed in 3D views. The following symbols are used:
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 Both trajectory and trace are displayed.
 Just   the trajectory is displayed.
,    Nothing   is displayed.

If a trajectory consists of more than one part   there is plus sign (+) in front of the 
label. The parts are shown by clicking   the plus sign or by using the left and right 
arrows.

 Note: In the Labeled trajectories   window the label can be edited by double-
clicking on the label. However,   in the other two windows the labels are always 
Unidentified and   Discarded followed by a sequential number, which can be used 
to   separate the trajectories.

Type 
The type of trajectory, which among others can be one of the following types.

Measured
A trajectory or a part that has been tracked from the measurement data.

Mixed 
A trajectory with a mix of the other trajectory types.

Gap-filled
A trajectory or part that has been calculated with the gap fill function.

Fill level 
The percentage of the current measurement range that the trajectory or   part is 
visible. The measurement range is selected using the Timeline   control bar.

Range 
The range of frames, within the measurement range, with data for the trajectory   or 
part.

X, Y and Z
The position (in mm) of the trajectory in the current frame. The coordinates   use 
the coordinate system of the motion capture system set up when the   system was 
calibrated. 

Residual
The average of the different residuals of the 3D point. This is a quality   check of 
the point’s measured position.

 Note: The residual is not available   for 2D tracked trajectories.

 Note: The number after the window name   is the number of trajectories in the 
window.

Sort trajectories
The data in the Trajectory info windows can be sorted by clicking the column headers. 
The trajectories are then sorted in ascending order for that column. Click on the column 
header to toggle between ascending and descending order.

To revert to the manual sorting in the Labeled trajectories window, right-click on the 
column header to open the Labels menu of the window and then select the Revert to 
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manual sorting option. The window will then show the trajectories in the order that the 
file was saved with.

Note: The sorting is only changed temporarily when looking at an open file. The 
sorting is reverted back to the manual sorting as soon as you close the file. If you want 
to change the manual sorting of the trajectories in a file you have to use the Move label 
up and Move label down options on the Trajectory info window menu.

Note: If you for some reason cannot revert to manual sorting, then try sorting the 
trajectories again to activate the Revert to manual sorting option.

Select and move trajectories
Select a trajectory in the Trajectory info window   by clicking on the trajectory. It is 
possible to select multiple trajectories   with standard Windows multiple selection 
methods. To deselect all trajectories,   either click on the Trajectory heading to deselect 
all or use Ctrl+Left-click   on the selected trajectories.

The trajectories can be moved to another Trajectory   info window by a simple drag and 
drop, either one by one or in a group.   If the trajectory is dropped in the Labeled 
trajectories window   the trajectory is labeled 'New 0000', where the number depends on 
how   many trajectories there are in the window.

Trajectories can also be joined by drag and drop. Select   a trajectory and drag and drop it 
on another trajectory or on an empty   label. The trajectory will then contain a new part. 
If the trajectories   overlap there will be a clash error, which must be handled. Trajectories   
where one of the trajectories or a part is completely overlapped by the   data of the other 
trajectory cannot be joined at all.

 Note: It is also possible to drag and   drop trajectories from and within the 3D view 
window.

Data info window and menu

The data for the current frame can be viewed in the Data   info windows. Open these 
windows by clicking Data info 1 to Data info 3  on the View menu. It is by default 
placed on the left side of the main   window. The following data can be viewed in the 
Data   info windows:

2D data for each camera 
(Use the option Current camera   if you want the 2D data of the last camera that 
you clicked on in a 2D   view)

6DOF data with position and   rotation
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Analog data from the analog   boards

Force data for the force plates

Use the Data info window   menu to switch between the data types and to plot data, it is 
accessed   by right-clicking in the Data info window.

Plot windows
The Plot windows display a graph of the data that   has been selected with the Plot 
command. The default window shows   the graph and the Legend box, see screen dump 
below. The Legend   box displays the names and colors of the series.

The graph contains the following default graphics:

 l A title above the plot, which shows what is plotted in the graph.   

 l A purple line in the plot, which represents the current frame in   the View 
windows.

 l An X-axis, which is always in frames.

 l A Y-axis, where the unit depends on what is plotted in the window.

Several plot options and tools are available via the toolbar, including a zoom   tool.

Project options dialog
The configuration of software and hardware settings in   QTM is accessed via the Project 
options on the Tools menu.   The settings are described in detail in the QTM   User 
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manual and some basic settings for a capture are described   in the chapter “QTM capture 
settings” on page 41.

Note: Most of the settings will only affect   a measurement if QTM is still in the 
preview mode, i.e. before the measurement   has started.
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Input devices settings overview

The Input Devices tree   in the Project options dialog   contains all of the settings used by 
the camera system and hardware in   a measurement. Only the most important settings are 
described below, for   a detailed description please refer to the Qualisys   User manual.
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Connecting to the system

Before the first use of the camera system it must be   connected to QTM. Make sure that 
the camera system hardware has been correctly   installed.

The connection of the camera system to the QTM software   is performed on the Camera 
System page in the Project options   dialog. When the connection has been made, the 
camera system can be   used as long as the properties are not changed.

Follow these steps to connect the camera system to QTM:

 1. Switch on the camera system, wait for the cameras to start up properly   and 
start QTM.

 2. Open the Project options dialog and go to the Camera System   page.

 3. Click Locate system.

 4. Click Start.

 5. Choose the camera system and click OK.
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Loading linearization files

A camera transmits coordinates in two dimensions for   each marker’s center point in the 
field of view of the camera. The locations   of the center points reflect the optical view of 
the sensor chip in the   camera. Since this cannot be done without distortion, the QTM 
software   must have information about the distortion of each camera in order to   get 
correct 3D data. This is achieved by an adjustment of the camera data   with a 
linearization procedure in QTM, which is then saved in a linearization   file and stored in 
the camera.

The linearization files of the current system are specified   on the Linearization page in 
the Project options   dialog. To load the linearization files stored in the cameras click on   
Load from cameras. A dialog appears   and QTM starts to load the linearization files 
from the Oqus cameras.

Calibration settings
To receive 3D data the system must be calibrated. The   most commonly used calibration 
is the Wand calibration that uses two calibration   objects to calibrate the system: the L-
shaped reference structure and   the calibration wand.
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The settings that must be   specified for the calibration are the Calibration   kit type and 
the Exact wand length.   Without these settings the calibration will be incorrect.

Marker settings
The two important settings for marker calculation are   Exposure time and Marker   
threshold. The steps and suggestions below provide a basic method for adjusting the   
settings. Please note that it is not possible to give more specific advice on how to adjust 
the settings, because of their dependence on the context and their interrelation. There 
are also other settings that can help to get a better   measurement, e.g. Marker   masking 
and Marker   discrimination.

First of all make sure that the focus and aperture are   correct, see “Setting the aperture 
and focus (Oqus)” on page 7 or “Setting aperture and focus (Miqus)” on page 13.

Exposure and threshold must be used together, because   changing one can lead to that 
you have to change the other. Follow these   steps to set exposure and threshold settings.

 1. Start a new measurement and stay in RT/preview mode. Use the Camera 
settings sidebar to change the settings.
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 2. Set the Exposure time at   200-300 microseconds (400 µs for older Oqus series 
1, 3  and 5) and Marker   Threshold to 20. These are the default values and 
often it is   a good starting point.

 3. Start by looking at the marker intensity image. Click on the   Marker 
intensity button in the   Camera settings sidebar to show   the marker intensity 
image. For more information see "Video preview in QTM" in the QTM 
manual.

 4. If the markers are not bright red in the marker intensity image,   try increasing 
the Exposure time   until they are bright red. For example with a longer 
distance to the markers,   you may need a longer exposure time.

 a. For higher frequencies it might not be possible to increase the   exposure 
so that the markers are bright red. However, as long as they   are brighter 
than the background the camera should be able to find them   by lowering 
the marker threshold.

 b. If there are extra reflections, you can try reducing the Exposure time. 
Extra reflections are   anything that is not a marker and has a color 
different from blue. Green   is the threshold level.

 c. Remember that you can set this setting individually for each camera,   see 
"Camera settings sidebar" in the QTM manual.

 5. Switch back to Marker mode and check if the markers are visible.   If they are 
not, go back to Marker intensity mode and adjust the Marker threshold 
value. It is not possible   to give an exact value for the threshold at a certain 
exposure, because   each setup is different.

 a. Increase the threshold if the background looks light blue or even   green 
in the marker intensity image. A light blue background will make   it 
harder for the camera to calculate the markers.

 b. Decrease the threshold if the markers are not bright red in the   marker 
intensity image. For example, at short exposure times of 100 µs   (200 µs 
for older Oqus series 1, 3 and 5) and lower the threshold needs to be 
low, usually   around 10-15.

 c. Make sure that the marker calculation is stable at the selected   threshold. 
If the threshold gets too low there will be a lot of extra   reflections or no 
markers at all. A too high threshold will result in   small markers or 
missing markers.
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 d. Remember that you can set this setting individually for each camera,   see 
"Camera settings sidebar" in the QTM manual.

 6. Finally check that the markers are large enough to give a good   accuracy. 
Check that the marker size is at least 200 in the Data   info window.
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Calibration overview
The QTM software must have information about the orientation   and position of each 
camera in order to track and perform calculations   on the 2D data into 3D data. The 
calibration is done by a well-defined   measurement procedure in QTM. 

There are two methods that can be used to calibrate   a camera system: Wand calibration 
and Fixed camera   calibration. Only Wand calibration is described in this Getting started   
manual. A fixed calibration requires a special installation of the camera system.

The following items are important to think about before   the calibration:

 l Before the calibration, make sure that the calibration settings   are correct on 
the Calibration page in the Project options   dialog. The focus and aperture of 
the cameras must also be set before   the calibration.

 l When using Wand calibration or Frame calibration it is important   that the 
camera system has been placed correctly to achieve a high-quality   
calibration, see section “Camera positioning” below.

 l It is recommended that the motion capture system is calibrated   before each 
measurement session to make sure that the captured data has   high quality. 
Check regularly that the calibration is OK during long measurement   sessions. 
For instructions on how to perform a wand calibration, see section “How to 
perform a Wand calibration” on the next page.
There is an automatic check if the cameras have moved via a threshold for 
the tracking residual. This is activated   on the Calibration Quality page   in 
the Project options dialog.

 Important:   Each time a camera in the system is moved (even the slightest) a 
calibration   must be performed before high-quality data can be captured again. However,   
some errors with a calibration can be fixed with reprocessing.

Camera positioning
Cameras must be mounted firmly on tripods or other stable   structures, which isolate the 
camera from movements or vibrations of any   sort. Once the system has been properly set 
up, the cameras must be arranged   to fit the measurement setup. When arranging the 
cameras, it is best if   they are in operating mode. 

 1. Start the measurement computer and the QTM software. 

 2. Open a new file with a 2D view window.

 3. Arrange the cameras to cover the entire measurement volume of the   wanted 
motion. It is suggested to mark the corners of the measurement   volume with 
markers, and use the 2D view window to make sure that   each camera can see 
the markers as expected. The Video   view can also be used to see the camera 
field of view.

 o The best setup for a 3D motion capture system is to position it   so that 
all cameras can see the L-shaped reference structure during the   
calibration.

 Note: The cameras can be positioned   so that just two of the cameras 
are able to see the calibration reference   object. The rest of the cameras 
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must then overlap each other’s field of   view (FOV) to be able to 
calibrate the system. For this setup QTM will   automatically use the 
Extended calibration method.

 o To reconstruct 3D data, at least two cameras must see each marker   
during the measurement. Therefore it is best to position the cameras so   
that as many cameras as possible see each marker during the 
measurement.

 o The angle of incidence between any two cameras should ideally be   more 
than 60 degrees and at least more than 30 degrees. The accuracy of   the 
3D data calculated from only two cameras placed at less than 30 degrees   
can degrade below usable levels.

 o In order to avoid unwanted reflections, position the cameras so   that 
every camera’s view of flashes from other cameras is minimized. E.g.   put 
the cameras above the measurement volume so that the cameras have   an 
angle of about 20 degrees in relation to the floor.

How to perform a Wand calibration
The Wand calibration method uses a calibration kit that   consists of two parts: an L-
shaped reference structure and a calibration   wand.

Place the L-shaped reference structure so that the desired   coordinate system of the 
motion capture is obtained. It is best if all   cameras in the system can see all markers on 
the reference structure.   This is not an unconditional requirement but it gives the highest 
accuracy.   If some cameras cannot see the reference structure the Extended calibration   
method is used automatically.

The calibration wand is moved inside the measurement   volume in all three directions. 
This is to assure that all axes are properly   scaled. The calibration algorithms will extract 
each camera's position   and orientation by evaluating the camera's view of the wand 
during the   calibration. To achieve a good calibration of the system, it is recommended   
that you follow these instructions on how to move the wand.

 l To assure that all cameras can see the wand as much as possible   during the 
calibration, make sure that the cameras are not blocked by   the person moving 
the wand around in the measurement volume. This ensures   that no camera 
will be blocked for a longer time period.

 l One suggestion on how to move the wand, is to move it in one direction   at a 
time. Start by holding the wand positioned in the Z direction, i.e.   the straight 
line between the two wand markers should be parallel to the   Z axis. Move 
the wand in the entire measurement volume. It is important   to fill the entire 
measurement volume with calibration points. Make sure   that both the lower 
and upper parts of the volume are covered. Repeat   the same procedure with 
the wand positioned in the X and Y direction.   It is particularly important to 
collect points where there will be many   markers during the motion capture.
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 Note: In this picture the reference   structure is not indicated to make the 
picture more distinct. The reference   structure must of course always be 
present during the calibration. The   box in the figure represents the 
measurement volume.

There are many other ways to move the wand and the optimal   moving method varies 
depending on the application, i.e. you have to find   out the best method for your 
application. It is recommended that the moving   method is systematic and easy to repeat.

The steps below are an outline of what should be done   to calibrate the camera system 
with Wand calibration method. 

Follow these steps to calibrate the camera system:

 1. Switch on the camera system and start QTM.

 2. Open a new file by clicking the New   file icon .

 3. Place the L-shaped reference structure in the measurement volume.

 4. Set the settings on the Calibration page in the Project   options dialog.

 5. Click OK.

 6. Click the Calibration icon  and set the settings in the Calibration   dialog.
 Note: A suitable setup to assure a correct   calibration of all cameras is to 

use 20-30 seconds for the calibration.   It is, however, very dependent on the 
size of the measurement volume.   You need to specify enough time to cover 
the entire volume with the wand.

 7. Click OK.

 8. Move the calibration wand in the measurement volume.

 9. Check that the calibration is OK in the Calibration results   dialog and click 
OK.

 Note: Each calibration is saved in a   QCA file in the Calibration folder in the 
Qualisys Track Manager   folder. The file name contains the date and time of the 
calibration.
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Capture overview
QTM can capture different data including marker, video,   force, EMG and analog data. 
There are two ways of collecting data in QTM,   either capture a file in QTM or run 
QTM in RT (preview) mode and then   collect the data in another program. Which one 
you use depends on your   application.

 Real time mode
The QTM real time process enables QTM to send data to   any program that can receive 
data on TCP/IP or UDP/IP. At the moment there   are interfaces for mobile devices (iOS 
and Android), Visual3D, Motion Monitor, Motionbuilder, Unity,  LabView and Matlab. 
Please contact Qualisys AB if you want to use these   interfaces. You can also write your 
own real-time client using the RT protocol, which is included in the QTM distribution.

QTM will process the 2D in real time as soon as a measurement   file is open in preview, 
i.e. when you click on New   in the File menu. The data can   then either be displayed in 
QTM or sent to another program.

The real time performance depends on the computer specifications, the   number of 
cameras and the number of markers.

The following processing steps can be done in real-time,   depending on the settings on 
the Processing   page in the Project options   dialog.

Pre-process 2D data

3D tracking

Apply the current AIM   models

Calculate 6DOF

Calculate force data

Calculate gaze vector data

This data can then be viewed in QTM and can also be sent   to another computer via 
TCP/IP. These are the different steps in the real-time   process.

 1. The cameras capture data at a fixed frequency.

 2. RT processing of data in QTM which is performed as fast as possible.

 3. Data is sent on the TCP/IP output. If QTM takes too long time processing   a 
frame, the next frame captured by the cameras will not be processed   at all. 
This is shown in the main status bar as decreased a RT frequency.

How to use real time
The following steps describe how to use real-time and   send the data to another program, 
for example Visual3D.

 1. Before   you start the real-time, make sure that you have an AIM model or   
6DOF bodies for the movement that you are going to capture.   

 Note: It is best if the AIM model has   been created on a measurement made 
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on the subject that will be captured.

 2. Switch   on the camera system and start QTM.

 3. Open   a new file by clicking the New file icon .

 4. Open   Project options dialog and go   to the Processing page. 

 5. Activate   the Real-time actions that you   want to use. For example, for 
Visual3D typically the following   actions are used: Pre-process 2D data, 
Track   each frame: 3D, Apply the current AIM   models and Calculate   force 
data.

 6. Check   the settings for the actions that have been selected.

 7. Go   to the Camera system page and   set the capture rate. The maximum 
capture rate depends mainly on the computer specifications, as well as the 
complexity of the AIM model.

 Note: Using a too low real-time frequency may lead to suboptimal 3D 
tracking depending on the velocity of the movements.

 8. Go   to the GUI page and set the Real time mode screen update to 15 Hz.   
This step is not necessary, but it will give the computer more time to   process 
the marker data.

 9. Test   the real-time with the motion that you want to capture. Look especially   
at how the AIM model is applied and if the RT frequency shown in the 
Status bar is close to the capture rate.   If it differs too much, lower the capture 
rate, it might also help with   a new AIM model or changing the tracking 
parameters.
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 a. If   the real-time is slow close all windows, including the Data   info 
window and the Trajectory   info windows, except for a 3D   view 
window.

 b. When   the real-time is working fine you can even turn off the GUI on the 
GUI page in the Projects Options dialog. This will   reduce the 
processing capacity needed by QTM.

 c. AIM   can be restarted with the Apply AIM model   button .

 10. When   you are satisfied with the real-time in QTM, you can connect to QTM 
from   the other program or client.

Capture measurement files
The reason for capturing data is to store the data from   the cameras. Captured data can 
then be processed and exported to other   programs. The QTM files store all of the data 
that is captured, including   marker, analog and force data. Video files can also be 
captured with the   Oqus camera or a DV camera, but are stored as separate AVI files.

How to capture a file
The steps below provide an outline of how to perform   a capture.

 1. Switch   on the camera system and start QTM.

 2. Select the project you want to use or create a new project.

 3. Open   a new file by clicking the New file icon . The cameras will start in 
the same mode   as last preview or measurement.

 Note: If the system has been calibrated   and is ready for a measurement you 
do not have to open a new file. Click   the Capture icon    and go directly to 
step 6. 

 4. Check   that the markers are visible, otherwise change the camera settings see   
chapter “Marker settings” on page 44.

 5. Calibrate   the system, see chapter “How to perform a Wand calibration” on 
page 48.

 6. Go   the Processing page in the Project   options dialog to activate any 
processing steps. 

 7. Click   the Capture icon .
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 8. Specify   the capture settings in Start   capture dialog.

Check especially the following settings:

Capture period       is how long the capture will be. You can also see the 
capture rate and      the number of frames to the right of the setting. When 
using continuous capture, the capture is not stopped before the Stop 
capture button  is pressed or a trigger stop event is received.

The       Automatic capture control settings can be used for saving the 
files     automatically, as well as for activating batch capture.

 9. Check   that all of the settings under the Camera   system settings heading are 
correct.

 10. Click   Start to start the capture. When   the capture is finished, all of the 
processing steps will be performed   and then the new motion capture file is 
displayed in QTM, unless batch   capture is activated. In batch capture, QTM 
will immediately start waiting   for the next capture as soon as the processing 
of the previous capture   is finished.   An ongoing capture can always be 
stopped with Stop capture on the Capture   menu or by clicking the Stop 
capture icon .

How to capture Qualisys video
Video capture with Qualisys cameras involves the following steps:

 1. Make sure that the cameras that will be used for recording video are in video 
mode.

 2. Choice of video settings (capture rate, exposure, compression, etc.). The 
available video settings and the interface for changing them in QTM depends 
on the camera model. The video capture rate can be set individually per 
camera and may be different from the capture rate of the cameras in marker 
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mode. Some camera models have the option to use in-camera MJPEG 
compression. This allows a longer capture, however, at a reduced maximum 
capture rate.

 3. Calibration of Qualisys video cameras is optional, but required for 3D 
overlay. Qualisys video cameras can be calibrated together with the marker 
cameras in the system. During the calibration, the Qualisys video camera will 
be automatically switched to marker mode, so it is important to make sure 
that the marker settings are correct.

 4. Start a new capture. Depending on the camera model and settings, video is 
streamed to QTM during the measurement or buffered on the camera and 
fetched after the capture is finished.

Note: Depending on the capture frequency streaming video cameras might 
store some frames during the capture. These frames are fetched after the 
capture is finished.

 5. The video from each camera will be stored in a separate AVI file and can be 
played back in QTM. You can then for example activate the 3D overlay on 
the video and export the view with the Export to AVI feature on the File 
menu.

Batch capture
With batch capture, QTM will capture several consecutive   measurements. Batch capture 
is activated with the Batch capture   option on the Start capture   dialog,   before the start 
of the measurements. In this dialog, the options Save   captured and processed 
measurement automatically and Add counter must also be selected so that the each 
measurement is saved in   a separate file.

Before each new measurement in a batch capture QTM will   wait for a start signal and 
the whole batch capture is stopped by a stop   signal. These signals are given in different 
ways depending on whether   external trigger is used or not. 

External trigger
If the external trigger is used to start each measurement, to stop the   batch capture 
you need to press Esc or click Close   on the File menu.  Stop capture on the 
Capture menu can be used during an individual capture to stop just that capture.

No external trigger
Start each measurement by clicking Yes   in the  Next measurement   dialog. Stop 
the batch capture by clicking No   in the dialog. Stop capture on the Capture 
menu can be used during an individual   capture to stop just that capture.

 Note: All of the processing steps that   are selected on the Processing  page in the 
Project options   dialog will be performed before the next measurement can start.
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Processing overview
After the capture is finished the data must be processed   in QTM to get 3D data, 6DOF 
data and force data. Some functions in QTM,   such as AIM and exports, can also be 
performed in processing. The processing   can be done automatically after the capture, 
manually in the current capture   file or automatically on saved files by using Batch 
processing.   

The settings of the automatic processing, which are the   same for the processing directly 
after capture and batch processing, are   specified on the Processing page in the Project 
options dialog.   The following processing steps are available on the page:

 1. Auto backup
This option will create an automatic backup file containing the captured   2D 
data before starting the other processing steps.

 2. Pre-process 2D data

 3. Track the measurement

 a. 3D

 b. 2D

 4. Merge with Twin slave

 5. Gap-fill the gaps

 6. Apply the current AIM models

 7. Calculate 6DOF

 8. Calculate force data

 9. Calculate gaze vector data

 10. Export to TSV

 11. Export to C3D format

 12. Export to Matlab file

 13. Export to AVI

The settings of each processing step can be reached from   the Processing page. This 
manual only describes settings for AIM. To   read more about the settings for other steps, 
please refer to the QTM User manual.

Batch processing
With batch processing, several capture files can be processed   with the same settings. 
The same actions can be performed in batch processing   as in the processing that is 
performed after a measurement has been captured.   

 Important:   If Track the measurement is used when batch processing, the tracking   
of the saved files will be changed. This means that all of the trajectories   will be 
unidentified again unless you apply AIM in the same batch process.

To start a batch process, follow the steps below.
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 1. Click Batch process on the File menu to open the   Batch processing dialog.

 2. Select the processing steps that you want to perform from the list.   The 
processing steps are the same as those that can be applied in post-processing.

 3. Choose the source for the settings from the drop-down lists to   the right. For 
some settings the only possible source is the project,   for the other settings 
there can be three possible options:

Processed file
The settings used are the ones present in each processed file and cannot   
be edited. This option is always selected by default because the other   
options remove the original settings from each file.

Project
The settings are copied from the current project to each processed file.   
The settings can be edited in the tree-view to the left. Editing the 
settings   will change the current project settings as well. This option is 
often   the best to use when you want to change the settings of the 
processed   files.

Present file
The settings are copied from the present file (the file open in the QTM   
window where you opened the Batch processing   dialog) and can be 
edited in the tree-view to the left. Only available   for Calculate 
6DOFand Calculate   force data.

 Note: For Track   the measurement the settings are split into Tracking   
parameters and Calibration settings   so that the sources of these settings can 
be set separately. Make sure   that the calibration is valid for all of the files 
you want to batch process   when using the option project.

 Note: For Calculate   force data the settings are split into Force   plate 
settings and Force plate   location so that the sources of these settings can be 
set separately.   This can for example be used on files where the location 
varies, but you   want to process the files with the same Force   plate settings. 
In this case, select processed   file as the source of Force plate   location and 
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select project   as the source of the Force plate settings.   Edit the force plate 
settings by selecting them in the tree on the left.

 4. Click OK. Select the files and click Open. The actions   are performed on the 
files and then the files are saved and closed.

 Note: Any changes to a capture file   are saved automatically, i.e. it will be 
saved if any step except the   export options are used.

Identification of trajectories
The first step when working with the data is to identify   the trajectories by giving them 
the correct label. This is either done   manually or automatically, with the use of an AIM 
model. When processing   a lot of measurements with the same marker setup it is 
recommended to   use an AIM model as it will significantly reduce the processing time.

Manual identification of trajectories
Even if you plan on using an AIM model to identify the   trajectories, you need to 
identify at least one file by hand, since an   identified file is needed to create an AIM 
model. Manual identification   can be performed with any of the following three methods, 
and they can   also be used together. 

Quick identification   method
Manual identification is best done with the quick identification method.   Follow 
these steps to use this method:

 1. To use the quick identification method you need to have a label   list in the 
Labeled trajectories window.   Load a label list or enter the labels manually 
with Add   new label on the Trajectory   info window menu.

 2. Select the first label in the Labeled   trajectories window that you want to 
identify.

 3. Hold down Ctrl + Alt or select the Quick   identification cursor  and click 
on the marker or trace in the 3D view window that matches the selected   
label.

 a. When you click on the marker or trace, it will be added to the   selected 
label. If you have not selected any label, the marker you click   on will be 
added to the first empty label in the list. If there is no   empty label in the 
list, the marker you click on will be added as a new   label at the end of 
the list, and you can edit its name at once.

 b. You can also add additional parts to a trajectory with the quick   
identification method. Select the labeled trajectory in the list, then   hold 
down Ctrl + Alt and click on the unidentified marker.
However, if the two trajectories cannot be joined (because of too much   
overlap) the selection will just move to the next label without any 
action.

 c. By holding down Shift when clicking on the trajectory you can join   a 
trajectory to the previous label in the Labeled   trajectories window. This 
option can for example be used if the   most recently identified trajectory 
only covers a part of the measurement   range. In this case, you can add 
more parts by clicking on the next part   while holding down Shift.
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 4. QTM will move the selection automatically to the next label in   the list. Hold 
down Ctrl + Alt every time you click on the next corresponding   marker. 
Continue until all markers in the Labeled   trajectories window are identified.

 5. You can start and restart the process on any label in the list.

 a. This means that if you click on the wrong marker, you can undo   the 
identification with Ctrl + Z and then make sure that the correct label   is 
selected and use quick identification again.

Drag and drop   method
Manual identification can also be performed by dragging and dropping 
trajectories.   The following drag and drop methods are available to identify 
trajectories.

From the Unidentified   trajectories window to the Labeled   trajectories 
window.

From the 3D   view window to the Labeled trajectories   window.

One trajectory (trace) in the 3D   view window to another trajectory (trace) in 
the 3D   view window.

A trajectory can be dropped either on a label   to add the data to that label or in 
the empty part of the Labeled   trajectories window to create a new label. If it is 
dropped on   a label that already contains data, the two parts will be joined if they   
do not overlap too much.

Identify method
It is also possible to use the Identify option on the Trajectory   info window 
menu, which appears whenever you right-click a trajectory,   either in a 3D view 
window or in a Trajectory info window.

The following features are useful when identifying   trajectories.

 l The keyboard shortcut C   can be used to center on the selected marker in a 
3D   view window.

 l The Trajectory info window   menu option Center trajectory in 3D,   will also 
center on the selected trajectory or part. However, if the trajectory   is not 
visible at current frame it will also move the current frame to   the first frame 
of the trajectory.

 l The keyboard shortcuts J and Shift + J can be used to jump to the next 
unidentified trajectory or part. 

  Automatic Identification of Markers (AIM)
Automatic identification of trajectories in the QTM software   is performed by a module 
called AIM (Automatic Identification of Markers).   The AIM model is created from 
identified files and can then be applied   to any measurement that captures similar 
motions with the same marker   set. This makes AIM very flexible and powerful - any 
motion can be made   into an AIM model.

Generating an AIM model
AIM needs a model file to work, which is generated from   a measurement or multiple 
measurements with identified trajectories. 
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 IMPORTANT:   To get the best AIM model it is important that you continue to 
add QTM files with the same marker setup to the   AIM model, if the automatic 
identification fails. You can add files with subjects of different sizes, as long as you 
have used the same method to place the markers. Use the Add   to existing model(s) 
setting when you identified the file manually, because if you create a new model   for 
each subject you will not use the full potential of the AIM functionality.

Follow the steps   below to add a file to a model file or generate a new model file.

 1. Make a measurement and identify all of the trajectories that will   be included 
in the model. The model becomes better if you follow the guidelines in 
“Guidelines for data added to AIM models” on page 65: The two most 
important guidelines are:

 o Make sure that the subject in the file is moving. The movement does not 
have to be exactly the same as the rest of the captures, just that it 
includes most of the movement. When you add more measurements to an 
AIM model, it becomes less important that the added files include a lot 
of movement.

Note: Even if you want to make an AIM model for a static 
measurement it is important to have some movement in the first file. This 
is to make sure that the internal bone definitions are correct. However, 
the subsequent files can be static because then the definition is already 
correct.

 o Make sure that the trajectories have the correct identity throughout the 
file. You can select a smaller measurement range to delete the incorrect 
parts if you do not want to identify the whole file.

 o In the first file used to generate an AIM model, it is recommended to not 
have any static markers together with the moving subject. Because it 
will make it very hard for AIM to find a solution. Only use an AIM 
model with static markers if the markers are always static.

 2. Select the measurement range of frames that will be used in the   model. Use 
the scroll boxes  on the Timeline   control bar to   select the range. Choose a 
range where the motion is typical for what   you are going to capture, most of 
the time it is best to use the whole   measurement range unless there are large 
gaps or incorrect data.

 3. Click the Generate model icon  on the AIM toolbar or click Generate   
model on the AIM menu.

 4. Select whether you want to Create   new model or Add to existing model. 
Use add to existing model if you already have an AIM model with the 
current marker setup.
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Create new model
Click Next and then verify the AIM bones. It is very important that the bones 
are connected in the correct way so that not the wrong markers are 
connected. If the bones are wrong try to use the Delete bones tool in the 
toolbar to remove the bones that are wrong. For more information about the 
AIM bones see section “How to verify and edit AIM bones” on page 66.
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Then select the directory where you want to save the model. The default 
location is to save it in the AIM folder of the project. Enter a File   name for 
the model and click OK. The model is generated automatically.

There can be two warnings when generating AIM models related to static 
markers.

 a. First if all labeled markers are too static there is a warning because a 
static measurement can lead to erroneous internal bones in the AIM 
model, for example two knees can be joined. This will then be used 
even if the added files are with a movement. You should only use an 
AIM model with static markers if the markers are always static.

 b. The other warning is if some of the labeled markers in the file are static 
while others are moving. The problem is the same as above that you will 
get internal bones in AIM that makes it harder to apply the model. If 
you need static markers you can either create a separate AIM model for 
those markers or have empty labels in the first AIM model and identify 
them manually.

Add to existing model
Select a model or models from the list to which you want to add the 
movement in the current   file. This   option is used to extend the motion of an 
existing model and therefore   improve how it is applied to a new subject. It is 
the recommended option if   you already have a model with the same marker 
setup. The previous AIM model is automatically saved in the AIM 
models/Backup folder.
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 o The models in the list are the models that are available on the   AIM 
page. By default all the models in the Applied models list   are selected. 
Click Add model to browse for another model.

 o The file must include   all the labeled trajectories that are included in the 
model. It can however   have other labeled trajectories as well, only those 
with the same name   as in the model will be used to update the model. 
This means that you   can update several models at the same time. E.g. if 
the file include three   person with different names on their respective 
labeled trajectories,   then you can select all three AIM models in the list 
at once and all three   models will be updated.

 o If you only add to one AIM model you will get a dialog that displays 
the AIM bones of the AIM model that is added to. If the AIM bones are 
placed incorrectly in the model it is best to make a new AIM model and 
start training that one instead.

 5. The dialog below is displayed when the AIM model has been created   or 
updated. If anything goes wrong in the process it will be displayed   in the 
Results list. For example you will get a warning if the first file is static or if 
the added file is too different and in those cases you can choose to abort the 
process.

If you created a new AIM model it is then loaded to the Applied   models list 
on the AIM  page in the Project   options dialog. Any other model in this list 
will be moved to Previously used models list.

If the data is added to an existing model, then   the model files are updated 
and nothing is changed on the Applied   models or Previously used models   
lists.

The model can now be applied to other measurements.
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Note: The procedure is the same if you use the Generate   from multiple files option 
on the AIM   menu, except that you select the files you want to use in a dialog. However 
it   is important that the files have the same labeled trajectories.

Guidelines for data added to AIM models
Follow these guidelines when you check the data before adding it to or creating an 
AIM model.

 l Make sure that the subject in the file is moving. The movement does not 
have to be exactly the same as the rest of the captures, just that it includes 
most of the movement. When you add more measurements to an AIM model, 
it becomes less important that the added files include a lot of movement. You 
can verify that the movement is large enough by looking at the AIM bones, 
see section “How to verify and edit AIM bones” on the next page.

Note: Even if you want to make an AIM model for a static measurement it 
is important to have some movement in the first file. This is to make sure that 
the internal bone definitions are correct. However, the subsequent files can be 
static because then the definition is already correct.

 l Make sure that the trajectories have the correct identity throughout the file. 
You can select a smaller measurement range to delete the incorrect parts if 
you do not want to identify the whole file.

 l The colors of the trajectories and any bones between them are also   saved in 
the model. For example to make it easier to verify the identification after   
AIM has been applied, the colors of the trajectories can be set with Set 
different colors on the  Trajectory   info window menu before creating the 
AIM model.

 l Trajectories that are left unidentified or discarded   will not be included in the 
model.

 l If you have several subjects in the same measurement it is recommended to 
make an AIM   model for each subject, see “AIM models for multiple subjects” 
in the QTM user manual.

The following two steps are not as important when you add files to the 
AIM model.

 l The AIM model will be better if all of the trajectories are visible   throughout 
the whole measurement.  Therefore it is a good idea to gap-fill   the trajectories 
as long as the gaps are relatively small. However if   there are large gaps it is 
sometimes better to omit the gaps by limiting   the measurement range in step 
2 below. This is especially important if   you use clusters, because then you 
have several trajectories that move   along the same path.

 l The data of each trajectory should be as good as possible. This is   especially 
important if your model includes trajectories that are close   to each other. 
Then a small erratic noise on a trajectory can make two   trajectory paths come 
very close to each other, which makes the identification   difficult. Therefore if 
the data is erratic, i.e. the trajectory movement   is not smooth when you play 
the file, you should delete the erratic data   by the following process:

 o Find the frame where the erratic data starts. Split the trajectory   at that 
frame.

 o Then step through the frames to locate where the trajectory data   is OK 
again. Split the trajectory again.
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 o Delete the part with erratic data that you have just created.

 o Repeat these steps for all of the frames where you can find erratic   data 
and then gap-fill the trajectories

How to verify and edit AIM bones
When an AIM model is created there are AIM bones created automatically between the 
markers that have least movement between them throughout the file. Because these AIM 
bones are then kept even if you add more measurements it is important that they are 
correct. Therefore there is a step when creating a new AIM model where you can verify 
and edit the AIM bones.

 l The AIM bones are displayed as red bones between the markers.

 l There is no relationship between the AIM bones and bones created by the 
user.

 l The number of AIM bones are as few as possible.

 l You can rotate, translate and zoom the 3D image of the AIM bones.

 l You can delete AIM bones with the Delete bone tool, see below.

 l The frame used for displaying the AIM model is the first frame that include 
all or as many as possible of the markers.

To verify that the AIM bones are correct follow these instructions:

 1. Check that all of the markers are displayed. If there are missing markers it 
means that there is no frame with all of the markers. It is recommended to use 
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another file where all of the markers are available in at least one frame.

 2. Check that the AIM bones are connected between the correct segments. For 
example if you are creating a model of a person that has been standing still 
then the knees and feet may be connected with AIM bones, see image below. 
Then use the Delete bone tool to remove the bones or select the bone and 
press Delete. Every time a bone is deleted AIM will look for a new solution, 
so you may have to delete several bones before you have the correct solution. 
This is especially true if the measurement is static, then it is often better to 
create a new file with more movement.

 3. The AIM bones may not look as good as your user created bones, but that 
does not necessarily mean that it is wrong. For example the AIM bone 
between a head and the body can look strange if the marker nearest to the 
head is on the shoulder.

Applying an AIM model 
The AIM model can be applied to files with captured motions   that are similar to any 
part of the motion in the model. I.e. if your   model includes a lot of different motions 
made by a human, then the captured   trajectories can be identified if another human 
makes one or more of these   motions.    An AIM model can be applied either   as a 
processing step or manually.

Below follows a description of how to apply an AIM model manually on a capture file.

 1. Open a capture file in QTM.

 2. Make sure that all of the trajectories are in the Unidentified   trajectories 
window or the Identified   trajectories window. Discarded trajectories are not 
used by AIM.   It is also important that all required parts of the measurement is 
included   in the selected measurement range, since the AIM model is only 
applied   to trajectories with parts within the selected measurement range.

 3. Click the Apply model icon  on the AIM toolbar or click Apply   model on 
the AIM menu. The AIM   application settings dialog is displayed.

Note: The AIM settings are copied from Project options, if you want to use 
the AIM settings and models saved in the file you need to reprocess the file 
and select from measurement as source, see chapter “Processing overview” 
on page 57.
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 4. Check that the Applied models   are correct. It is possible to apply several 
AIM models to the same file, for more information see “AIM models for 
multiple subjects” in the QTM user manual.

 5. Click OK, the AIM module   will try to apply the model to the measurement. 
Click Cancel   in the dialog below to abort AIM.

If any of the models cannot be applied to the   trajectories the dialog below 
will appear. Showing how many of the bodies   (models) were applied.

The AIM results   dialog will display the result of all of the applied AIM 
models. The Partial results are AIM models where   not all of the markers 
have been identified. For the Failed   models none of the markers have been 
identified. 

The most likely reason for the Partial   result is that the model doesn't 
completely match the captured motion. Then it is recommended to manually 
identify the file and then add it to the existing   AIM model, see “Generating 
an AIM model” on page 60.
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Note: When you get a partial solution it is recommended to retrack the file 
before trying to apply a modified AIM model, since the cuttings made by 
AIM can make it harder to apply AIM the next time.

It can also help to reduce the selected measurement   range so that the AIM 
model is applied only on a smaller part of the measurement.   For example, if 
the subject walks in and out of the volume it can help   to reduce the selected 
measurement range to where the subject is inside   the volume.

 6. Check the file to see whether all of the trajectories have been   identified 
correctly. There are two main reasons that trajectories are   not identified, for 
more information about AIM see chapter “How AIM identifies trajectories” 
below.

 o AIM will join parts of trajectories that are within the AIM model 
definition and also split the trajectory if it is too much outside the AIM 
model definition. Therefore if there are some trajectories that are not 
identified in a part of the measurement it probably did not match the 
model in that part. The solution is to identify the markers and then add 
the file to the AIM model.

 o AIM sometimes cannot identify a trajectory if a nearby trajectory   is 
missing during that part of the measurement.

 7. When the AIM model has been successfully applied, the capture file   must be 
saved to keep the changes.

When you apply a model as a processing step, either directly   after a capture or in a 
batch process, it works exactly like when applying   it manually. The model is set on the 
AIM page in the Project options   dialog.

How AIM identifies trajectories
AIM identifies trajectories from angles and distances   between markers. In the AIM 
model QTM has saved the angle and distance   ranges of added measurement files. This is 
the reason why it works better when you add more measurements since the AIM model 
will then include  more movements. When the model   is applied AIM tries to find the 
solution that fits these ranges the best.

There are a few limitations to AIM that are good to know:

 1. AIM does not work on only two markers. The main reason is that   AIM works 
in local coordinates, i.e. it does not take into account whether   "marker x is to 
the left of marker y". AIM only cares about   "what location marker x has 
compared to the locations of markers   y and z". This means that there is no 
left/right, over/below or in   front of/behind in the model.

 2. AIM needs to have movement in the first file used to create the model. 
Otherwise AIM will not identify the correct bones in the AIM model, since 
the bones are based on the shortest possible distances between markers.

 3. AIM looks for the best solution in each frame and then joins the solutions. 
This means that AIM will join and split trajectories depending on the AIM 
model so that you get the best match. The measurement subject can leave and 
enter the volume and AIM will continue to join the trajectories.

 4. Because AIM is working with relations between markers, all of the   markers 
in the model file must be included in the measurement to ensure   that all of 
the trajectories can be identified. E.g. if a marker on the   shoulder disappears 
for a long time it is difficult for AIM to find the   arm.
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Qualisys AB is continuously working on improving AIM   so please contact us if you 
have any questions.

Data export to other applications
The data in QTM can be exported to other applications   for external analysis. The data 
export can be done either as a processing   step or manually. To export the data manually 
go to the File   menu and the Export sub-menu.   The file formats that are exported during 
processing are selected on the   Processing page in the Project options dialog.

The data can be exported to the following formats:

TSV format
Tab separated file that can in be opened in e.g. Microsoft Excel.

C3D format
Motion capture industry file format that can be used in e.g. Visual3D,   Motion 
Monitor and MotionBuilder.

MAT file
The data is exported in a struct array either in a MAT-file.

AVI file
Export 3D and 2D views to an AVI file that can for example be displayed in a 
presentation.
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IR radiation notice and environmental reg-
ulations

IR radiation notice
The Qualisys  camera uses short but quite strong infrared flashes to illuminate the   
markers. The flash is generated by LEDs on the front of the camera. The   Qualisys 
cameras belong to the exempt group according to IEC / SS-EN 62471 and are within the 
limits of the FDA CFR 1040.10   Class I classification, which means that the LED 
radiation is not considered   to be hazardous. 

However, any light of high intensity might be harmful   to your eyes. Because infrared 
light is invisible to the human eye, you   can be exposed to IR light without noticing. 
Therefore we recommend that   you do not stare directly at the LEDs at a short distance 
for a prolonged   time period when the camera is running.

EU customer information about about Waste 
Electrical and Electronic Equipment (WEEE)
In the European Union (EU), waste from electrical and   electronic equipment (WEEE) is 
now subject to regulation designed to prevent   the disposal of such waste and to 
encourage prior treatment measures to   minimize the amount of waste ultimately 
disposed. In particular, the EU   WEEE Directive 2002/96/EC requires that producers of 
electronic equipment   be responsible for the collection, reuse, recycling and treatment of 
WEEE   which the producer places on the EU market after August 13, 2005. Qualisys   is 
providing the following collection process to comply with the WEEE   Directive.

Qualisys WEEE Collection Process
If you have purchased Qualisys products in the EU on   and after August 13, 2005, and 
are intending to discard these products   at the end of their useful life, please do not 
dispose of them in a landfill   or with household or municipal waste. Qualisys has labeled 
its electronic   products with the WEEE label to alert our customers that products bearing   
this label should not be disposed with waste in the EU. Instead, Qualisys   requests you 
to return those products using the instructions provided   here, so that the products can be 
collected, dismantled for reuse and   recycled, and properly disposed.

Qualisys will take back WEEE, i.e. all of the electrical   equipment which is part of 
Qualisys equipment, from its customers within   the EU. Please visit the website 
www.qualisys.com/weee or contact Qualisys   AB at weee@qualisys.com for information 
on how to return your WEEE.
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China ROHS (in Chinese)
有害物质声明

按照中华人民共和国电子工业标准SJ/T11364   2006的要求，此文档提供了由

Qualisys AB生产制造的Oqus1-，3-和5-系列的危险材料声明。

部件

名称

有毒有害物质或元素

 铅 汞 镉 六

价

铬

多溴

联苯

多溴二

苯醚

印制

电路

配件

x o o o o o

显示

器

x o o o o o

按钮 o o o o o o
内部

配线

o o o o o o

围栏 o o o o o o
镜头 x o o o o o
外接

电缆

及端

口

o o o o o o

交流

电 /
直流

电电

源

o o o o o o

纸质

说明

书

o o o o o o

CD
说明

书

o o o o o o

O：表示该有毒有害物质在该部件所有均质材料中的含量均在SJ/T   11363-2006
标准规定的限量要求以下。

X：表示该有毒有害物质至少在该部件的某一均质材料中的含量超出SJ/T   
11363-2006标准规定的限量要求。
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